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PMLA advertising electronic file submission specifications

All advertisements should be submitted in Adobe Acrobat PDF format and e-mailed to pdfads@mla.org.
Additional information about submitting ads for PMLA is available on the MLA Web site. For information
about Adobe Acrobat products and PDF documents, please visit Adobe's Web site at http://www.adobe.com/
acrofamily/main.html.

To make sure files are printed correctly, please adhere to the following guidelines.
Submission specifications

Ad pages: Please submit each ad as a separate PDF document. Do not send multiple ads as
spreads or multiple pages in one PDF file.

Document size: Ads must be submitted at 100% of final ad size; no bleeds or crop marks
should be included with the ad. Full-page ads are 6 inches wide by 8.75 inches high; half-
page ads are 6 inches wide by 4.25 inches high.

PDF final output: Composite, high-resolution (300 to 600 dpi), PDF file(s) only, please.
Additionally, PDF documents should not contain any of the following Acrobat features:
annotations, comments, signatures, printer marks, passwords, security options,
attachments, live hypertext links, bookmarks, embedded movies, links to external
applications, document read / flow settings, or metadata.

Important: When creating PDF files using Quark XPress v. 5 or later, deselect the OPI
PPC extension in the XTension Manager found in the Utilities menu.

Fonts: All fonts used in the advertisement must be embedded in the PDF file. Use PostScript
fonts only; do not use TrueType fonts.

Embedded art: All embedded art must be high-resolution (300 to 600 dpi), grayscale art, or
vector graphics; do not use RGB values. Note: PMLA is printed in black and white.
Please do not submit any color artwork.

Colors: Convert all document color values to CMYK or grayscale. All predefined application
RGB colors must be removed from your document; do not use Pantone or spot colors.

Document encoding: When creating PDF documents, use Binary encoding instead of ASCII.

Compression.: Do not use file compression in any art files; turn off LZW compression for
embedded TIFF files. If using Adobe Acrobat Distiller, please refer to the PMLA job
option settings later in this document.

File names: Please use the following file naming convention when saving and naming
PDF files:

PublisherName PMLA-Pubdate ad#.pdf

For example, a PDF file placed in the March 2003 issue of PMLA by the MLA would be
named MLA_PMLA-March03_ad.pdf. If there is more than one advertisement being
inserted in the same issue, add a number for each file at the end of the file name.
Examples: MLA_PMLA-March03_ad02.pdf, and MLA_PMLA-March03_ad03.pdf.


mailto:pdfads@mla.org
http://www.mla.org/www_mla_org/publications/publications_main.asp?area=&section=pub5310114447&mode=sub&level=1#adspecs
http://www.adobe.com/acrofamily/main.html
http://www.adobe.com/acrofamily/main.html

PMLA advertising electronic file submission specifications

Submitting files: PMLA accepts electronic submissions either on optical disks (CDs) or by e-
mail (for PDF file size less than 1 MB). If submitting more than one file by e-mail to
PMLA, please compress the PDF files by using Stuffit Expander if working on a Mac or
PK Zip if using Windows. Please add the appropriate file suffix .sit or .zip to the archive.

Proof: In addition to the PDF file, please mail a hard-copy laser proof of the ad at 100% of
the document’s size to Annabel Schneider, Advertising Manager, PMLA, Modern
Language Association, 26 Broadway, 3™ floor, New York, NY 10004-1789.
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PostScripting Instructions for Quark XPress v. 4.11 documents
1. Before PostScripting your files, choose a postscript printer from your Print Menu.

2. Return to your Quark XPress document. Choose Print from the File menu, then edit to match the following
settings.

New »
Open... ®0
Close W
Save £33
Save as... WSS

Revert to Saved

Get Text/Picture... #E
Save Text... #SSE
Append... HESEA

Save Page as EPS... #5545
Collect for Output...

Document Setup... #SS4GP
Page Setup... i
- ®P

| Quit #Q |

3. In the Pages range, enter the page to save as a PostScript file. (Each ad must have its own PDF file.)

=————————— Print
Print Style:
Copies: |I | Pages: |AII ||L| [ Range Separators... |
Document | Setup | Output | Options | Freview |
[ Separations [ Spreads [ Collate
O Include Blank Pages O Thumbnails [ Back to Front

Page Sequence: Bleed:
Registration: Offset:
Tiling: Overlap: [ Absolute Overlap

Page Setup...] [ Printer... ] ‘ [ Capture Settings ] [ Cancel ] H Print ]l

4. Click the Page Setup button and edit to match the following settings.

Laser¥riter 8 Page Setup 8.7.1

- | Page Attributes i]

Format for: [LaserJet4V i]

Paper: [I_etter ij

A
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5. Click on the Page Attributes pop-up menu and select PostScript Options. Clear all selections and click OK to

return to Print Settings.

LaserWriter 8 Page Setup

271

- | PostScript™ Options i]

Yisual Effects:

[ Flip Horizontal
[ Flip ¥ertical
O Invert Image

ﬁizj Image & Text:
[ Substitute Fonts
[ Smooth Text
[ Smooth Graphics
[ Precision Bitmap Alignment

[ Unlimited Downloadable Fonts

[ Cancel ] “ 0K

6. Click the Setup tab and edit to match the following screen capture.

frint=a—"————————————

Print 5tyle: | PMLA advertising «

Copies: |I | Pages: |AII

||L| [ Range Separators... |

Cocurnent | Setup | Output T Opticns T Preview ]

Printer Description: | Acrobat Distiller «

Reduce or Enlarge: |100% [ Fit in Print Area

IEi

Page Positioning: Center v Orientation:

Paper Size: Letter
Paper Width: Paper Offset: I:I
Paper Height: Page Gap: I:I

Page Setup...] [ Printer... ] ‘ [ Capture Settings ] [ Cancel ] H Print ]l

7. Click the Output tab and edit to match the following screen capture.

PrintD4Am\s\ssss—————————

Print 5tyle: | PhLA advertising «

Copies: |I | Pages: |AII

|t| [ Range Separaturs...]

Docurnent T Setup Tl]utputT Optionz T Preview ]

Print Colors: | Composite CMYK
Halftoning:

Resolution: | 2400 w | {(dpi)
Frequency: E‘ (Ipi}

Print |Plate |Ha|ftone |Fr'equenc>yI v|.\’mg|e 'lFunction -
o Process Cyan - 150 105* Default
+ Process Magenta 5 150 75" Default
+ Process Yellow = 150 a0 Default
+ Process Elack = 150 43% Default ||
Page Setup...] [ Printer... ] [ Capture Settings ] [ Cancel ] |[ Print ]|
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8. Click the Options tab and edit to match the following screen capture.

Print

Print 5tyle: | PhLA advertising «

Copies: |I | Pages: |AII |t| [ Range Separaturs...]

Docurnent T Setup T Output TDptionsT Preview ]

[ Quark PostScript Error Handler

age Flip: | None « egative Prin
P, Fli N [ Negative Print

Pictures

Data: [ Overprint EPS Black
OFI: Include Images v B4 Full Resolution TIFF Qutput

[ Page Setup...] [ Printer... ] ‘ [ Capture Settings ] [ Cancel ] |[ Print ]|

Note: Set Data option to Binary encoding. Do not use ASCIL

9. Click on the Printer... button at the bottom of the Print options window. Make sure the PostScript printer is
selected and that Destination is set to File.

Printer: [I_aserJet4V i] Destination: | File =

- [ save as File =

Format: [ PostScript Job i]

PostScript Level: O Level 1 Compatible
@ Level 2 and 3

Data Format: () ASCIH
@ Binary

Font Inclusion: [AII i]

CGancer ) oo )

10. Select the Font Settings options and make sure Type 1 and Always download needed fonts are checked.

271
Printer: [I_aserJet4V i] Destination: | File =
- [ Font Settings =
- Font Documentation
] Annotate Font Keys
- Font Downloading
Changes from the Default Settings may affect printing performance or appeatance.
Preferred Format: @ Type 1 ) TrueType
b Always download needed fonts
I Newver generate Type 42 format LUse Defaults
Save Settings [ Cancel ] H Save ]l
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11. Select the Save as File options and make sure Format is set to PostScript Job, Level is set to Level 2 and 3,
Data is set to Binary, and Font Inclusion is set to All.

2.7.1
Printer: [ Laserlet 4¥ i] Destination: | File =
- [ save as File =
Format: [ PostScript lob i]
PostScript Level: O Level 1 Compatible
@ Level 2 and 3
Data Format: () ASCIH
@ Binary
Font Inclusion: [AII i]
Save Settings [ Cancel ] H Save ]l

12. Click on the Save button and save the document with .ps as the file name extension. Name each PostScript
file as follows: Publisher PMLA-Issuedate ad#.ps. For example: if the MLA is placing an advertisement in
the March 2003 issue of PMLA the file name would be as follows: MLA_PMLA-March03_ad01.ps.

[ E Desktop i] = Voyager
El MLA-1.¥0L2 S| [ Eect |
= Yovyager I
[ Banta (v.2) Desktop |
FY captions15-35 o
| Document B

Create File:
| MLA_PMLA-March03_ad.ps |

Note: When saving files, please do not use special characters such as slashes (/) in the file name. Use
alphanumeric characters and underscores () only.

13. Click the Save button and then click the Print button in the Quark print window to save the file as a
PostScript document. Once the file is saved you are ready to create PDF files.
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PostScripting Instructions for Quark XPress v. S documents

1. Before PostScripting your files, make sure the OPI PPC extension is inactive by deselecting it in the
XTensions Manager found in the Utilities menu. When deactivating the extension, make sure to Quit out of
Quark XPress and restart your application for changes to take place. PDF files created with the OPI PPC
extension active will not print correctly.

=——————— XIensions Manager
Check Spelling b
2:;':3%?‘;:;!?“6”'" Set: [ No Sef i] [ Save As...] [ Delete ]
Suggested Hyphenation... 3H [ Import... ] [ Export... l
Hyphenation Exceptions...
Usage... Enable ~|Name | status

b Kern-Track Editor Active
Component Status... ol LZW Import PPC Active =
PPD Manager-... s MS-Word 6-2000 Filter Active ﬂ
QuarkLink N OF1 PPC Ina_ctive
Show Tagged Content ¥ PCXX I_rnpurt PPC Act!ve |
Guide Manager.. W PDF Filter PPC Active g
Build Index... o PhotoCD Import PPC Active =]
Jlabber
Tracking Edit...
Kerning Table Edit...
Remove Manual Kerning
Line Check » Cancel ] [ 0K ]l
Convert 0ld Underlines

2. Choose a postscript printer from your Print Menu.

3. Return to your Quark XPress document. Choose Print from the File menu, then edit to match the following
settings.

New 2
Open [ 3
Close W
Save S
Save as... CHES
Revert to 5aved

Get Text/Picture... #E
Save Text... CHEE
Append... SCHA
Export 3
Save Page as EPS.. "C{O 35
Collect for Output...
Document 5etup... “CO%P
Page Setup... CHEP

Print...

| ouit %0 |
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4. In the Pages range, enter the page to save as a PostScript file. (Each ad must have its own PDF file.)

Print

Print Style: [« PMLA =]

Copies: II I Pages: IAII |@
Doeumean Setup T Output T Options | Bleed | Prewiew ]

[ Separations [ Spreads [ collate
[ Print Blank Pages [ Thumbnails [] Back to Front

Page 5equence:
Tiling: Overlap: I:I [] Absolute Overlap

Page Setup... | [ Printer.. | ‘ ["Capture settings | [ cancel | [ print ||

5. Click the Page Setup button and edit to match the following settings.

Laser¥riter 8 Page Setup 8.7.1
- | Page Attributes E
Format for: [ LaserJet 4V =)
Paper: [I_etter ij
%:j Orientation: |
Scale:%
I
(cancel | [ ok ]

6. Click on the Page Attributes pop-up menu and select PostScript Options. Clear all selections and click OK to
return to Print Settings.

Laserwriter 8 Page Setup 871

- | PostScript™ Options i]

Yisual Effects:

[ Flip Horizontal
[ Flip ¥ertical
O Invert Image

ﬁizj Image & Text:
[ Substitute Fonts
[ Smooth Text
[ Smooth Graphics
[ Precision Bitmap Alignment

[ Unlimited Downloadable Fonts

[ Cancel ] “ 0K ]l
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7. Click the Setup tab and edit to match the following screen capture.

Print

Print Style: [ PMLA

Copies: Il I Pages: |AII |@

Docurnent TSelupT Output T Options | Bleed | Prewiew ]

Hﬂuu o

Printer Description: [ Acrobat Distiller

Paper 5ize: [ Letter

Paper Width: Paper Offset:

Paper Height: 66p [51 Page Gap:

Reduce or Enlarge: |100% [ Fit in Print Area

Page Positioning: Center = Orientation:

Page Setup...] [ Printer... ] ‘ [ Capture 5Settings ] [Cancel ] “ Print ]|

8. Click the Output tab and edit to match the following screen capture.

Print
Print Style: [ PMLA B
Copies: |l | Pages: |AII |@
Docurnent T Setup Tl]utputT Options | Bleed | Preview ]

Print Colors: | Composite CMYK 2] Resolution: [2400 | 2] (dpi)
Halftoning: [(onventional i] Freguency: @ {Ipi)
Frint |Plate |Ha|ftone |Frequency vl Angle vlFunction bl

+ Process Cyan - 150 105* Default
+ Process Magenta - 150 75 Default
+ Process Yellow - 150 a0 Default
+ Process Black - 150 45 Default
Page Setup...] [ Printer... ] ‘ [ Capture 5Settings ] [ Cancel ] “ Print ]|

9. Click the Options tab and edit to match the following screen capture.

Print

Print Style: [ PMLA B

Copies: |I | Pages: |AII |@

Docurnent T Setup T Output TDptions Eleed | Prewiew ]

[ Quark PostScript Error Handler
Page Flip: [ None i] [ Negative Print

—Pictures
Output: [ Normal

[] Full Res of Rotated Objects
[ overprint EPS Black
b4 Full Resolution TIFF Qutput

Data: [Binar;-r

[o)lelle]

OFI: [Inl:lude Images

[ Page Setup...] [ Printer... ] ‘ [ Capture Settings ] [ Cancel ] |[ Print ]|

Note: Set Data option to Binary encoding. Do not use ASCIL



PMLA advertising electronic file submission specifications

10. Click on the Bleed tab and edit to match the following screen capture.

Print

Print Style: [ PMLA B
Copies: ]I | Pages: ]AII |@

Documnent | Setup | Output | Optionz | Bleed | Freview |

Bleed Type: Asymmetric s Top:

[ dlip at Bleed Edge Bottom:

Right:
Page Setup...] [ Printer... ] [ Capture Settings ] [ Cancel ] |[ Print ]|
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11. Click on the Printer... button at the bottom of the Print options window. Make sure the PostScript printer is

selected and that Destination is set to File.

Printer: [I_aserJet4V i] Destination: | File

- [ save as File =

Format: [ PostScript Job i]

PostScript Level: O Level 1 Compatible
@ Level 2 and 3

Data Format: () ASCIH
@ Binary

Font Inclusion: [AII i]

CGancer ) oo )

12. Select the Font Settings options and make sure Type 1 and Always download needed fonts are checked.

271
Printer: [I_aserJet4V i] Destination: | File =
- [ Font Settings =
- Font Documentation
] Annotate Font Keys
- Font Downloading
Changes from the Default Settings may affect printing performance or appeatance.
Preferred Format: @ Type 1 ) TrueType
b Always download needed fonts
I Newver generate Type 42 format LUse Defaults
Save Settings [ Cancel ] H Save ]l
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13. Select the Save as File options and make sure Format is set to PostScript Job, Level is set to Level 2 and 3,
Data is set to Binary, and Font Inclusion is set to All.

2.7.1
Printer: [ Laserlet 4¥ i] Destination: | File =
- [ save as File =
Format: [ PostScript lob i]
PostScript Level: O Level 1 Compatible
@ Level 2 and 3
Data Format: () ASCIH
@ Binary
Font Inclusion: [AII i]
Save Settings [ Cancel ] H Save ]l

14. Click on the Save button and save the document with .ps as the file name extension. Name each PostScript
file as follows: Publisher PMLA-Issuedate ad#.ps. For example: if the MLA is placing an advertisement in
the March 2003 issue of PMLA the file name would be as follows: MLA_PMLA-March03_ad01.ps.

[ E Desktop i] = Voyager
El MLA-1.¥0L2 S| [ Eect |
= Yovyager I
[ Banta (v.2) Desktop |
FY captions15-35 o
| Document B

Create File:
| MLA_PMLA-March03_ad.ps |

Note: When saving files, please do not use special characters such as slashes (/) in the file name. Use
alphanumeric characters and underscores () only.

15. Click the Save button and then click the Print button in the Quark print window to save the file as a
PostScript document. Once the file is saved you are ready to create PDF files.
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Creating PDF Files in Acrobat Distiller 5 from PostScript files

1. Launch Adobe Acrobat Distiller application.

2. In Distiller’s main window, select PMLA job options if they were e-mailed to you.

Acrobat Distiller

B

Job Options: |+ Banta {D1/03)

Cadmus {Profession)

Compatibility] CRC
—Info__________ | (reoPDFPages
File: none eBook Luse “
Size: McMNaughton-Gunn e—
G MLA Website ol jth
PCP_5.0prepress{3.0)
— Progress PMLA I
Status: Ready PMLA_ads
Press
1 Print |

Screen

Aerobat Distiller 5.00
Started: Friday, January 24, =
Adobe PostSoript software version: 2011.104

SheridanPress

&

12

3. If you lack PMLA’s job options, we recommend you create your own PMLA settings by copying the settings

specified in the screen shots below and saving them with an appropriate name for future reference:

Job Options: PMLA_ads

General \ / Compression \/ Fonts \/ Color \ / Advanced

_ File Options

Compatibility: | Acrobat 4.0 {PDF 1.3) -

[ Optimize For Fast Web View
] Embed Thumbnails
[ Auto-Rotate Pages: [ Collectively By File | + |

Distill Pages: @ All

Resolution: | 2400 dpi

_ Default Page Size

Width:

85 Units:[ Inches i]

Height:

1"

!

Job Options: PMLA_ads

m Compression Fonts Color Advanced

— Color Images

[ Bicubic Downsampling to ﬂ dpi

forimages above: dpi

b4 Compression: ZIP =
quatiey:

_ Grayscale Images

(=} [ Bicubic Downsampling to ﬂ dpi
forimages above: dpi
4 Compression:

Quality: 8-bit ¥

— Monochrome Images

[} [Bicubic Downsampling to ¥ I dpi
for images above: dpi

4 Compression:

[ Anti-Alias to gray: @

b4 Compress Text and Line Art

!

Note: It is very important that your settings for Compatibility are set to Acrobat 4 (PDF 1.3).
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ob Options: PMLA_ad

ob Options: PMLA_ads

General \ / Compression \/ Fonts \/ Color \ / Advanced General \ / Compression \/ Fonts \ / Color \/ Advanced

& Embed All Fonts __ Adobe Color Settings
Subset Embedded Fonts When Percent i ©
% Settings File: | None =
o Of Characters Used Is Less Than: Cancel g [ —J Cancel

When Embedding Fails: | Cancel Job ¥ — Color M Policies
i save As... | [Leave Color Unchanged B

_Ei

Base 14 Fonts 4 Always Embed: Intent: [ Default =

Courier _Working Spaces

Courier-Bald =
Cour ier-EoldOblique Gray: | None =

!

Courlcr0b]idue RGB: [ SRGB IEC61966-2.1 <]
Helvetioa |

el nat (= CMYK: [ US. Web Coated (SWOP) v2 +]
HebreticaBoldlblique —~

Hebretica-Oblique Never Embed: — Device-D Data

Symbal [ Preserve Overprint Settings

Tincs.Bold Preserve Under Color Removal and Black Generation

Tires-Boldltalic E
Preserve | % | Transfer Functions
Times-Italic »

Times-Roman [4 Preserve Halftone Information

A ]

ZapfDingbats

4D

AddName...| [ Remove |

Note: It is very important that Subset Embedded Fonts is left unchecked.

ob Options: PMLA_ads

General \ / Compression \/ Fonts \/ Color \ / Advanced

— Options
[ Use Prologue.ps and Epilogue.ps

[ Allow Postscript File To Override Job Options

Preserve Level 2 copypage Semantics
[ save Portable Job Ticket Inside PDF File
[ Mustrator Overprint Mode

[ Convert Gradients To Smooth Shades
[J ASCII Format

!

_ Document Structuring Conventions (DSCy
b4 Process DSC Comments

[ Log DSCWarnings

Resize Page and Center Artwork for EPS Files
[ Preserve EPS Information from DSC

4 Preserve OPl Comments

Preserve Document Information from DSC

Note: It is very important that Preserve OPI Comments and Preserve Document Information from DSC are
selected.

4. Go to the Settings Menu and choose Security. Make sure that no security options are applied to your PDF
files.

ecurity

_ Specify Password

[ Password Required to Open Document

[ Password Required to Change Permissions and Passwords

— Permissions
Encryption Level: 40-bit RC4 (Acrobat 3x, 4x)

[1 No Printing
[ No Changing the Document
[ Mo Content Copying or Extraction, Disable Accessil

[ Mo Adding or Changing Comments and Form Fields

=3
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5. Once the job options are selected, distill the PostScript file by either dragging the file’s icon over Distiller’s
job window or by opening the file from the File menu.

6. Distiller will automatically create PDF files. The final PDF files are saved to the same folder or directory
where your PostScript file is located or to a location you specify.

7. Open the newly created PDF file and check for any type, image, or layout errors. If the file appears to be

correct, please print a copy to send as a proof and follow the submission instructions on page 2 of this
document.



